b DCDEE

* Regulatory Application

Complaint Form
» Facility
» Facility History D1 41001070 | Operation Type:| Center |
b Visk Status] Active | Save
> Pont Name of Operation: | PRECIOUS BEGINNINGS CHILD DEVELOPMENT CENTER|
» Capacity, S/C Ratio
» Owner Date Received: _ .
Ao (112372006 | Received by: | BRIDGGETTE CAMPBELL v | View Only
» Compiant Complaint referred to:
: :t:?t:[iun s ) AN Case number| 0106-231L Consultant| AUDREY DAVIS v
s Criminal Racords Ll nsing Detesent | 1/24/2006
» WORKS E;E:Eve . 1/24/2006
: m Fage Bg?;pleted
» HELPI | DSS Conclusions Case Time Frame Type of Closure
HELPFUL HINTS | vl From: (A/N Only) | v |
int Receiveﬁ:| |

Field Case Decision:

If you investigated a complaint
in conjunction with another visit. To:
you may need to show your 0.
type of contact as 'Other’.

Date Mailed: |

Contact (Investigation method)

Time in
i Time
Date| 2/27/2006 | out
Total minutes 95 | Minutes | Time in
Time
out

| MNo. children present

Ref. {:c:de:| 05 | e |

Operational Status

| Legal/Regulated v |
Complaint Categaory

| Licensing v|

Complaint Allegation

|ﬂr‘| nnannonnecad wicit wac made 1 1 3 1nt




DCDEE

Regulatory Application

‘ Complaint Allegation

| Legal/Hegulated W |
Complaint Category

Earili x ;
' I':'E'C':'t‘r ¥ | Licensing v|
b Faciity History . a s : : . .
An unannounced visit was made to this Center to investigate the attached complaint
> Visit p 2 S i L : :
: report which states that visual superwvision 1s not maintained at all times and
» Permit staff/child ratios are not maintained.
v Capacity, S/C Ratio y
» Owner | :
- Nature/Resolution:
» Administrator — N
» Complaint Staff/Child ratio @ S x:' u o f:l Medications t S , J T8I
» Action U gidrmra soda OsOu o L staff qualifications JsOu o
» Sanitation Inspection || Nutrition Clgs Ol Cle || Permit restrictions OsQOu' o
» Criminal Records L Transportation OsQullo | Sanitation/Health O=s0ullp
» WORKS o OO & ! Records QsODul o
~ i apaci . - i s =
» Search Page i L staff L Children Program
> Logoul Supervision OsOu o [ Discipline sOu o
[ Unlicensed Facil Qg0 = f
» HELP! s tf— ==Y Q || Criminal record A5 O 0
|l Residential | Commercial
- ELFH"' i o s, L] Abuse/MNeglect s Oy 0
Hint L Unreported accident S5 U 0 - _ .
S — ; = L Sexual LJ Physical L MNeglect
If you investigated a complaint . L .
in conjunction with another visit | Nurture/Care/Treatment of Children 8 U 0O ! Developmentally Appropriate Activities AR A
you may need to show your — RS
type of contact as 'Other’ || Safe Environment \s\ lp 0 (o O=0Ou -
. Outdoor L] Indoor _ _
7 Violations New
List to use: | Center v| Item Section List ==
301 B1 Center Delet
Type: | Complaint Lic v | 1301G3 Center it
View
Edit All
MS Word
Add Section

e sriationge




e DCDEE

* Regulatory Application

Violations New
» Faciliy List to use: | Center v ltem Section List - ==
s Facil 301 B1 Center
> E’::'IW i Type: | Complaint Lic v | 1301G3 Center Tl
. View
» Permit
» Capacity, S/C Ratio Edit All
» Owner MS Word
> Administrator Add Section
» Complaint
» Action _
» Sanitation Inspection
» Criminal Records :
» WORKS I\Dbsewatlﬂns
» Search Page During today's wvisit, there were two caregivers present with two groups of
» Logout children. One group was cared for in the room for infants and consisted offjl}

children ages @ to 2. The other caregiver cared for 12 children age 1 to school
» HELP! age.

HELPFUL HINTS You, co-owner stated that you do not recall a time in January when there was no
] caregiver in the room for infants. The teacher for infants did not remember if
Hﬁmhwaﬁgﬂ&dacnmﬂaht she was off that day for an appointment. You did not have staff records on site
in conjunction with another visit, to verify what staff was present on 1/11/@6. There was not enocugh information

you may need to show your available to determine if the portion of the complaint pertaining to supervision
type of contact as 'Other’.

cnuld he cithetantiated NDurine tndav's wielt all Fhildren were wicnuallw Lo

4 || Comments

A return unannounced visit will be made to monitor violations cited during this =
visit.

Technical assistance and other topics discussed during today's visit are:

Today I explained to you that staff/ child ratios must be maintained at all times
including rest time.

New child care rules which went into effect January 1, 20806 were reviewed with you
and a packet explaining the new rules left with you.

!:9




he DCDEE

* Regulatory Application

LINKS

» Facility

» Facility History

» Visit

» Permit

» Capacity, 5/C Ratio
p Owner

» Administrator

» Complaint

» Action

» Sanitation Inspection
» Criminal Records

» WORKS

» Search Page

r Logout

» HELP!

HELPFUL HINTS

If you investigated a complaint
in conjunction with another visit,
you may need to show your
type of contact as 'Other’.

. Violations New
List to use: | Center v ftem Section List - ==
301 B1 Center —
Type: | Complaint Lic v | 1301G3 Center elete
View
Edit All
MS Word
Add Section
Observations
HSL}DE'F'"L-"ISE'{]. -

You did not have attendance records for children or staff available for January
11th for my use in determining staff/ child ratios for that day. However, during
today's visit, one staff cared for 12 children age 1 to school age. Another
staff cared for|khildren ages @ to 2. Since staff child ratios were out of
compliance during today's wvisit, the allegation regarding staftf child ratio 1is
substantiated.

Four violations were cited in the process of investigating the contents of the
complaint as follows: .

25/

"Cumments

F S

MNew child care rules which went into effect January 1, 2006 were reviewed with you
and a packet explaining the new rules left with vou.

You sald the Owner of Precious Beginnings attended a training on the new
sanitation rules. You received a sanitation inspection from Paula Cox,
Environmental Health Specialist in Guilford County in January 2006. You received
9 demerits and a "superior” rating.

'You can reach me by phone at 748-4661 if you need additional assistance. *

::9




< DCDEE

Regulatory Application

Complaint Form

» Facility
» Facility History ID:|41 001070 |.peration Type:| Center |
> Visit ) Status:|Active | Save
’ =
PMM. . Name eof @peration: |PRECIOUS BEGINNINGS CHILD DEVEL®PMENT CENTER|
» Capacity, S/C Ratio
x Cwres sl Received by: | LKNIGHT |V' Onl
- [4/2/2007 | eceived by: v | View Only
+ Complaint Complaint referred te:
P
- 1 O AN Case number| 04070281 Censultant| DPARRISH v |
» Saniialion Inspaction ® ! :
» Criminal Records LickrisMs Date sent  |4/2/2007 |
» WORKS Lele Wy 4272007 |
» Seaich Page Al
Completed
* Logaut Date
» HELPf DSS Conclusiens Case Time Frame Type of Clesure
HELPFUL HINTS | v | Frem: (A/N @nly) | v |
| fu investigated a cemplaint Recewed:| | Bl e SR i - . . |
in conjunction with another visit Te' ' .| Date Ma“ed~,
you may need to shew yeur e
type of contact as '@ther’.

Centact (Investigatien method)

! Time in
7 Time
Date: 4/3/2007 | ot
Total minutes-95 | Minutes Time in
Time
eut

No. children present
Ref. Code:| || 16

@®perational Status
Legal/Regulated v—|
Complaint Category

 Licensing VJ

Complaint Allegatien

6 lT.be_dm(c:zc-_bac fheen 11c g the Bl



DCDEE

Regulatory Application

—r -

LINKS Licensing v
» Facility The daycare has been using the oven for heating as the gas had been cut off for a
» Facility History period of time. The lights in the daycare have been cut off several times. It 1is
b Vigi unknown if the daycare has running water at this time.
Visit
» Permit 4
» Capacity, 5/C Ratio MNature/Resolution:
» Owner ] staffiChild ratio OsOu 0 [ Medications OsQullo
i Amnlnlsn-atﬂr |:| BUildn‘lﬁrE 'Cﬂ‘dE II:'I S I‘-;’I U ':l' [:l Etﬂﬁ qUEliﬂCEtiU‘HS '::::I E I;:::' U D
» Complaint 2% e = vi
» AcSion L) Mutrition :J S ':: u o || Permit restrictions “: S :” U0
y Sanitation Inneckion [ Transportation OsOu o L sanitationHealth OsOu o
» Criminal Records M Capacity e e & L Records B B (el Yy
» WORKS B L B L) staff || Children L Program
» Search Page |:| Supervision OsQu. o L Discipline syl
L i i (e =0
» ' —! Unlicensed Facili L A S,
Logout — W— o U £ || Criminal record Q 5 O u O
|_! Residential || Commercial
> -
HELP! - e O) || Abuse/Neglect Desy 'o
! Unreported accident LS A 0 - - _
HELPFUL HINTS O sexual (J Physical [ Neglect
Hint | = ~N —
S — - L) Nurture/Care/Treatment of Children 8 U 0O L Developmentally Appropriate Activities sy D
If you investigated a complaint ) Safe Envi ; Yo ()
in conjunction with another visit, o= E_I I'I".-'II"DI'II'I'IEF['I_ it L C}ther| OOy @iy
you may nead to show your B sl
type of contact as 'Other’. g Hhace
Violations New
List to use: W i ;
o | Center | Edit
Type: | Complaint Lic » | [ icle
View
Edit All
MS Word
Add Section
Observations




< DCDEE

Regulatory Application

» Facility

» Facility History

» Visit

» Permit

» Capacity, S/C Ratio
» Owner

» Administrator

» Complaint

b Action

» Sanitation Inspection
» Criminal Records
» WORKS

» Search Page

» Logout

» HELP!

HELPFUL HINTS

If you investigated a complaint

in conjunction with another visit,
you may need to show your
type of contact as 'Other’.

1hﬂ:ul{:ltju:sns New
List to use:| Center v| B -
Type: | Complaint Lic v | Delete
View
Edit All
MS Word
Add Section
'Observations
o
I!:}r
Comments

{E




b DCDEE

* Regulatory Application
LINKS -
IR Complaint Form

» Facility
» Facility History ID1 41001070 | Name of Operation: s

| ave
> Visit |F‘RECIDUS BEGINNINGS CHILD DEVELOPMENT CENTER
» Pami

. Date Received: _
» Capacity, S/C Ratio |4,"9;"2[JD3 | Received by: | VALERIE RAEFORD v | View Only
» Owner
» Administrator Complaint referred to:
» Complaint ® A/N Case number| 0403-037A Consultant | MARGARET NICHOLS b
» Act .

. | O  Datesent |4/9/2003
» Sanitation Inspection Licensing Date
» Crminal Records et 4/9/2003
» WORKS Completed
» Search Fﬂ;ﬂ Date
» Logout -

DSS Conclusions Case Time Frame Type of Closure

» HELP! | v Erraer (A/N Only) | v

Field Case Decision:

To:

HELPFUL HINTS Re::eived:| |

Date Mailed:| |

If you investigated a complaint
in conjunction with another visit,

you may nead to show your S
type of contact as 'Other’ Contact (Investigation method)

Time in
Time
| Dateq 4/15/2003 | it
Total minutes:60 | Minutes | Time in
Time
out

| MNo. children present

Ref. Code |6 | 16 |

Operational Status

| Legal/Regulated V|
Complaint Category
AN v

\ o

Complaint Allegation




DCDEE

Regulatory Application

] "-.FUI1I||JILvIIIIL UUL\JHUI}'
LINKS A/N 5
» Facility
» Facility History
b Visit
» Permit 4
> Capacity, SIC Ratio Nature/Resolution:
b‘ — = — — P e
o - StaffiChild ratio OsOu o L Medications OsOu o
b Administrator = ST = Sl
» Complaint L] Buildfira code Jslp 0 L staff gualifications wAa U O
» Action ) Nutrition & O U 9] L Permit restrictions ) 5 O U (9]
» Sanitation Inspection L Transportation Qs Oullio || Sanitation/Health OsOu o
» Criminal Records A | Records OgO
E| Capac—_j‘t? L/ G Lt L 0 — ['_‘ ._'l 5 U O
» WORKS ! staff LI Children ! Program
» search Page | Supervision OsQu' o ] Discipline e o
» Logout () Unlicensed Facil OsO =
M IWD Sh el Y ! Criminal record SSASU LSO
» HELP! —' Hesidential Commercial
0] A (Y Abuse/MNeglect () g @ U o
; ®
HELPEUL HINTS Unreported accident s T b O M ] e ]
S ) Sexual ) Physical | Neglect
—— : = () Nurture/Care/Treatment of Children (05 O U O O Developmentally Appropriate Activities OsOu O
If you investigated a complaint — Ny
in conjunction with another visit. ) Safe Environment SESASY O | | Oec®
you may need to show your M (] Other 54U 0
type of contact as 'Other’. — Qutdoor ' Indoor
Violations New
~ | List to use: | Center v | =
Type: | Complaint A/N v | Delete
View
Edit All
MS Word
Add Section
'Observations H




W DCDEE

Regulatory Application

LINKS ! "

. Violations New
» Facility List to use: | Center v . Edit
» Facility History

> Visit Type: | Complaint A/N v | Delete
» Pemit View
» Capacity, 5/C Ratio Edit All

» Owner
» Administrator MS Word

» Complaint Add Section
» Action
» Sanitation Inspection —,

» Criminal Records Ob :
» WORKS servations

» Search Page
» Logout

» HELP!

HELPFUL HINTS

in conjunction with another visit,
you may need to show your
type of contact as 'Other’.

25/

# | IComments




b DCDEE

* Regulatory Application
LINKS :
IR Complaint Form
» Facility
» Facility History D1 41001070 | Operation Type:| Center |
> Visit | Statu5:| Active | Save
> Pont Name of Operation: | PRECIOUS BEGINNINGS CHILD DEVELOPMENT CENTER|
» Capacity, S/C Ratio
bl Siasiietaas Received by: | BLOVETT | View Onl
ecene z b ew un
» Administrator 19/22/2004 | Y Y
» Compiant Complaint referred to:
b ol _ @AN  Case number| 0904-127A Consultant| MARGARET NICHOLS v
» Sanitation Inspection o
» Criminal Records erions Date sent 9/22/2004
» WORKS r[:;zve . 9/22/2004
» Search P
» Logout e Completed
Date
> HELP DSS Conclusions Case Time Frame Type of Closure
HELPFUL HINTS | Unsubstantiated - | From: (A/N Only) | NSNA v |

REEEWE‘[T3| 1/14/2005 | Field Case Decision:

If you investigated a complaint
in conjunction with another visit. To:
you may need to show your 0.
type of contact as 'Other’.

Date Mailed; 1/18/2005 |

Contact (Investigation method)

Time in
i Time
Date 9/23/2004 | out
Total minutes:100 | Minutes | Time in
Time
out

| MNo. children present

Ref. {:c:de:| 2 | g |

Operational Status

| Legal/Regulated v |
Complaint Categaory
AN v

Complaint Allegation




W DCDEE

Regulatory Application

» Facility List to use: | Center sk | ltem Section List - Edit

» Facility History 1320G2 Center

» Visit Type: | Complaint A/N v | 1323G2 Center Delete

» Pamit 1324G2 Center VI-EW

» Capacity, 5/C Ratio Edit All

» Owner MS Word

» Administrator Add Section
» Complaint

» Action =

» Sanitation Inspection

» Criminal Records Ob :
» WORKS servations

» Search Page
» Logout

» HELP!

HELPFUL HINTS

in conjunction with another visit,
you may need to show your
type of contact as 'Other’.

25/

# | IComments




b DCDEE

* Regulatory Application
LINKS :
IR Complaint Form
» Facility
» Facilty History ID1 41001070 | Operation Type:| Center |
> Visit Status] Active | Save
, |
- Name of Operation: | PRECIOUS BEGINNINGS CHILD DEVELOPMENT CENTER|
» Capacity, 5/C Ratio
b St Received by: | LKNIGHT View Onl
» Administrator 10/13/2006 | didrtlat it 4 v | View Only
» Complant Complaint referred to:
: ‘:;‘:“;Um — O AN Case number| 1006-237L Consultant| AUDREY DAVIS v |
» Criminal Records L(%E asing Datesent | 10/13/2006
» WORKS r[:g;ve . 10/13/2006
» Search Page
- Completed
v Logout Date 11/14/2006
* HELPA DSS Conclusions Case Time Frame Type of Closure
_HELPFUL HINTS | v | From: (A/N Only) | v |

REEEWEU3| | Field Case Decision:

If you investigated a complaint
in conjunction with another visit, To-
you may need to show your 0.
type of contact as 'Other’. : :

Contact (Investigation method)

Date Mailed: |

Time in
i Time
Date| 11/14/2006 | out
Total minutes:60 | Minutes | Time in
Time
out

| Mo. children present

Ref. Cﬂde:| 04 | - |

Operational Status

| Legal/Regulated v |
Complaint Category

| Licensing V|

e |ﬂr‘| pnannatneasd wicit wac made 0 thic renter o ol lovi—nin mn alleoastinne roagarding ﬁ-.|

Complaint Allegation




DCDEE

Regulatory Application

» Facility

» Facility History

» Visit

» Permil

» Capacity, S/C Ratio
b Owner

» Administrator

» Complaint

» Action

» Sanitation Inspection
» Criminal Records

» WORKS

» Search Page

» Logout

» HELP!

If you investigated a complaint
in conjunction with another visit.
you may need to show your
type of contact as 'Other’.

‘ Complaint Allegation

| Legal/Regulated v |

Complaint Category

| Licensing v|
' |An unannounced visit was made to this center to follow-up on allegations regarding
the operator's attempt to falsify information.
e
The Reporter stated that staff files contained NC Early Childhood Credential o
MNature/Resolution:
[ Staff/Child ratio OsOu o [ Medications OsOullo
L] Buildffire code QsOul o || staff qualifications Os g l)s
L Nutrition OesQullo || Permit restrictions OsQu' o
O Transportation Os0Qu O L] Sanitation/Health OsQOuy 0
L] capacity Os0Ou ' 0o . i - - OsOu o
L staff L Children Program
- Supervision Us Oy O L Discipline OUsOuy 0O
] Unlicensed Facil OsO = 1
o2 v = A | Criminal record Qs0ul'o
|| Residential || Commercial
B : ~ 1] Abuse/Neglect OeOpy 0o
! Unreported accident w5 A 0 — — _
L Sexual LJ Physical L Meglect
) Nurture/CarefTreatment of Children s U © U Developmentally Appropriate Activities OsOy' o
] - OeO —r . . =
= e BIIOnER, i L Other | falsification of information | ®sOuy o
L Outdoor L] Indoor
Violations New
List to use:| Center v Item Section List Edit
108 G3 Center Delet
Type: | Complaint Lic v | it
View
Edit All
MS Word
Add Section

| [Observations




b DCDEE

* Regulatory Application

LINKS

» Facility

» Facility History

» Visit

» Permit

» Capacity, S/C Ratio
b Owner

» Administrator

» Complaint

» Action

» Sanitation Inspection
» Cniminal Records

» WORKS

» Search Page

» Logout

» HELP!

HELPFUL HINTS

If you investigated a complaint
in conjunction with another visit.
you may need to show your
type of contact as 'Other’.

List to use:| Center v|

Type:

Violations New
Item Section List - Edit
108 G3 Center

| Complaint Lic v | Delete

View
Edit All
MS Word
Add Section

Observations

During today's wvisit, files for two former staff members were observed which
contained Credential certificates dated March 21, 28@5.

The co-owner's file also contains a Credential certificate dated December 16,
2001.

A call was placed to the Work Force office of the Division of Child Development.
Susan Summerlin, Education Evaluator, assisted me by looking up the three
individuals in the system. Ms. Summerlin stated that the Division of Child

Development has not issued Credential Certificates to any of the individuals in
Che ctated further that the binrlk Farre nffire 1 the nnly nffircre that 7

-

nuestinn

E

'‘Comments

This attempt to falsify infeormation will result in a recommendation to the Raleigh =
office of the Division of Child to issue an Administrative Action against this
license.

Please keep in mind that if an Administrative Action is issued, you will be
required to notify in writing all parents of children currently enrolled at this
center of the details surrounding the Action. The Action must be maintailned for
three years in 3-ring binder easily visible to parents.

All statf must meet the requirements of their position when hired or be in the
nroress nf meetine the reanirements within six months nf emnlovment #

EI




he DCDEE

* Regulatory Application

» Facility

v Facility History

» Visit

» Permit

» Capacity, 5/C Ratio
p Owner

» Administrator

» Complaint

» Action

» Sanitation Inspection
» Criminal Records

» WORKS

» Search Page

» Logout

» HELP!

HELPFUL HINTS

If you investigated a complaint
in conjunction with another visit,
you may need to show your
type of contact as 'Other’.

Violations Mew
List to use: | Center v ltem Section List - =
108 G3 Center Delot
Type: | Complaint Lic V| i
View
Edit All
MS Word
Add Section
Observations
I“lr'IvEJ1"u"ll::.ll_li3J_S in the 5}’51:E{’rl. Fls. Summerllin stated That Tthne LUvision or Lhlild a

Development has not issued Credential Certificates to any of the individuals in
question. She stated further that the Work Force office is the only office that
distributes these certificates.

You, co-owner of this facility stated that vou will go GTCC tomorrow, MNovember
15, 2086 and regquest that an official transcript be mailed directly from GTCC to
my office .

Since three North Carolina Early Childhood Credential certificates which appear

in the files could not be verified 1n Raleigh, this compliant 1is substantiated. y

25/

E"CDmments

TN1s atLempt O Talsity 1NTOrMAL1ON WILL Fesult 1n a recommendactlon Lo LNe Ralelgn
office of the Division of Child to issue an Administrative Action against this
license.

Please keep in mind that if an Administrative Action is issued, you will be
required to notify in writing all parents of children currently enrolled at this
center of the details surrounding the Action. The Action must be maintained for
three years in 3-ring binder easily wvisible to parents.

All staff must meet the requirements of their positicon when hired or be in the
process of meeting the reqguirements within six months of employment.

F

::9




h< DCDEE

* Regulatory Application

LINKS -
BTN Complaint Form
» Facility
» Faciliy History ID; 41001070  Operation Type:| Center |
> Visit Statu5:| Active | Save
. .
Ponm Name of Operation: | PRECIOUS BEGINNINGS CHILD DEVELOPMENT CENTER|

» Capacity, 5/C Ratio
b Cumex i Received by: | BRIDGGETTE CAMPBELL | View Onl

eceve : v | View On
» Administrator 12/14/2004 | y y
> Complaint Complaint referred to:
: ‘:;':“ﬂ;ﬁm spackon O AN Case number| 1204-202L Consultant| AUDREY DAVIS v |
» Criminal Records L{Eﬂnsing Date sent 12/15/2004
» WORKS iﬁve . [12/15/2004
» Search Page
» Logout - Completed

Date
» HELP DSS Conclusions Case Time Frame Type of Closure
HELPFUL HINTS | v | From: (A/N Only) | v
Receiveﬁ:| | - S
Field Case Decision:

If you investigated a complaint S
inycunjunctiﬂﬁ with anoth nia] r visit, To: Date Ma||e{1.| |
you may need to show your 0

type of contact as 'Other. : :
Contact (Investigation method)

Time in
s Time
Date] 12/15/2004 | out
Total minutes:90 | Minutes | Time in
Time
out

| MNo. children present

Ref Cﬂde:| 10 | = |

Operational Status

| Legal/Regulated v |
Complaint Category

| Licensing *v*|

Complaint Allegation




< DCDEE

Regulatory Application

» Facility

» Facility Hstory

» Visit

» Pannit

» Capacity, SIC Ratip
» Owner

» Administrator

» Comptaint

» Actron

» Sanialion Inspachion
» Csiminal Records
» WORKS

» Search Page

» Logout

» HEL P!

Q__;rungtr—n_l

If you investigated a c esmplaint
in conjunction with anaother visit
you may need to shew yeur
type of contact as '@ther’.

Complaint Allegatien

| Legalikeguiatea v |

Complaint Category

L[_icensing vj

B
Nature/Reselution:
U stafrchild ratie OsOu e [ Medications O sOwiCig
D Buildffire code O S O ) [ J D Staf¥ qualificatiens O S O U 0]
D Nutiition O S O U ¢ D Peimit restiictions O S O U O
U Transpaiiation CsQu e U Sanitatien'Health OsQu O
D Records O O
& capact Os®u 0 S AU AL
s O staf (J ch iidren O Pregram
- Supelvision CsQui'e O Discipline CsQu O
UJ Unlicersed Facil O
BACE TS Y S O J ¢ D Criminal record O S O U O
C] Residential D Commergial
| (] Abuse/Negkct Ols Quitlo
€ Unreparted accident CsQui'e
() sexuat UJ Physical U Neglect
D Nuiture/CarefTreatment of Children O S O U [ ] D Devele pmentall ropriate Activities O S O U O
pm y Approp
C] ]
Safe Emvironment O S O U e 0 ®ther O a O U 5
C] Outdoor D Indeer
Violatiens New
List te use:| Cerier v [tem Section List - Edi
1052C3 Center Dokt
Type: fComplax’nt Lic v ol
View
Edit All
MS Werd
Add Sectien

@ servatiens




W DCDEE

Regulatory Application

» Facility

» Facility History

» Visit

» Permit

» Capacity, S/C Ratio
» Owner

» Administrator

» Complaint

» Action

» Sanitation Inspection
» Criminal Records

» WORKS

» Search Page

» Logout

» HELP!

HELPFUL HINTS

If you investigated a complaint

in conjunction with another visit,
you may need to show your
type of contact as 'Other’.

. Violations New
List to use: | Center v ffem Sechon LSt - =
1052C3 Center Skt
Type: | Complaint Lic » | elete
View
Edit All
MS Word
Add Section
Observations
A
25/
Commenis
A




	cmplnt_41001070_01232006
	Screenshot (18)
	Screenshot (19)
	Screenshot (20)
	Screenshot (22)

	cmplnt_41001070_04022007
	Screenshot (11)
	Screenshot (12)
	Screenshot (13)

	cmplnt_41001070_04092003
	Screenshot (29)
	Screenshot (30)
	Screenshot (31)

	cmplnt_41001070_09222004
	Screenshot (26)
	Screenshot (28)

	cmplnt_41001070_10132006
	Screenshot (14)
	Screenshot (15)
	Screenshot (16)
	Screenshot (17)

	cmplnt_41001070_12142004
	Screenshot (23)
	Screenshot (24)
	Screenshot (25)




